Creating a PowerPoint 2007 Presentation

Starting PowerPoint 2007

In this tutorial, whenever we indicate that you need to click a mouse button, it will mean to click the left mouse button – unless we indicate that you should click the right mouse button. So, always move the cursor over the “place” we indicate and “click left” unless we tell you otherwise.

If you have been using PowerPoint 97, 2000, XP/2002 or 2007 this will be a wonderful journey. You will find many exciting new features and enhancements. Almost everything is “graphical.” When PowerPoint opens, the appearance of the screen will be very different. Once you get used to the new 2007 features, we think you’ll find it much easier to use as you create and edit your PowerPoint slides.

In the image below you’ll immediately see that the Menu Bar has been replaced by Tabs and Ribbons. The Tabs and Ribbons are then divided into Groups. We’ll be working with these new features in detail as we move through the tutorial.

Notice, in the image on the last page, that the screen is “sort of” divided into three sections.
Across the top are the Microsoft Office Button, the Quick Access Toolbar and the Tabs, Ribbons and Groups (indicated on the last page).

If you refer to the Introduction to Microsoft 2007 Tutorial you’ll find a detailed explanation of how to use these new features.

On the left side of the PowerPoint screen you’ll see an area that indicates Outline and Slides at the top. When you first open PowerPoint 2007 you’ll notice that the Slides Tab is “white.” This means that you’ll be able to see a small version of each slide as we create it.

To the lower right-center of the screen, you’ll see a PowerPoint Design Template. We’ll be using these templates to create our slide show. We’ll come back to this in more detail later in the tutorial.
Beginning the presentation

Slide 1

In PowerPoint 2007 a Slide Layout named Title Slide always appears first. PowerPoint “thinks” that you want to start your presentation with a title. So, logically, the Title Slide appears in the main section of the screen.

After you understand PowerPoint a bit more, you can choose any of the layouts you desire. We’ll show you how to do this as we proceed through the tutorial.

You will notice, in the lower left corner of the screen, Slide 1 of 1 is indicated.

You will also see that your screen looks like the image below.

Now we’ll have some fun and create a PowerPoint 2007 presentation on how to make a Peanut Butter and Jelly sandwich.

Place your cursor in the “Click to add title” box and Click the left mouse button. Your text box, after you click, will look similar to the one below.
To insert the text in this formatted text box, we simply enter (type-in) the title: How to Make a Great PBJ – go ahead and type this text in the box.

Now, Click in the second box “Click to add sub-title” and type:

A Gourmet Recipe (tap the Enter key)
From (tap the Enter key)
Your Name (type in your name like Janie Schwark or Greg Butler)

New Slide Button

Now it’s time to create the next slide in your presentation. To do this, we’ll need to find the New Slide button.

At the top left of the screen, in the Home Tab you will see a New Slide “button” which looks like the image on the right.

When you move your cursor arrow over the button you will see a Microsoft Help Text box appear that says New Slide.

Now this is a bit tricky….. Look carefully at the lower right corner of the New Slide button and you will see a down arrow.

Click-on the down arrow to create your next slide.

If you accidentally click the button, and a new slide appears, don’t worry, we’ll show you how to change to the slide format you desire later in the tutorial.

When you click the arrow an image similar to the one on the right will appear. We’ll use the Title and Content slide for our second slide. Click this choice.
**Slide 2**

Your new Slide 2 should look like the image below – even if you did not click the arrow.

For those who are familiar with previous versions of PowerPoint, you will notice that several different Slide Layouts have been combined into this smaller number of choices. All of the Layouts are available, but in new “combinations.”

The **Title and Content** slide (on the right) combines several of the Text and Content Layouts. We can choose to use the Bulleted List, or the Content choices. For Slide 2 we’ll use the Bulleted List. We’ll use the Content choices later.

Click in the **Click to add title** box and type: **Ingredients**.

Click in the • **Click to add text** box and type:

- **Crunchy peanut butter** (tap Enter)
- **Homemade strawberry jam** (tap Enter)
- **Two slices of white bread** (tap Enter)
- **Milk**

Your Slide 2 should look like the image on the right.

Notice how each line appears with a “bullet” (•) in front of it.
As soon as you began typing “Crunchy peanut butter,” you probably noticed that PowerPoint guessed that you wanted to use this Layout as a Bulleted list – so it took away the Content choices. This is a new feature in PowerPoint 2007.

**Saving your work**

Now would be a good time to save your work for the first time.

Notice, you have the small save diskette in the Quick Access Toolbar.

However, there is no longer a Menu Bar with File - Save. The Microsoft Office Button is now used for File menu choices.

Click the Microsoft Office Button and the menu on the right will appear. Notice that we purposely moved our cursor over Save As and it turned orange. We did this so you can see the various Save choices on the right side of the menu screen under Save a copy of the document.

Notice…………… You now have several new choices for saving your presentation.

**PowerPoint Presentation** – saves your presentation as a .XML (Extensible Markup Language) file. This is a new saving format that creates a smaller file size. However, this file type is not compatible with older versions of PowerPoint. So, if you share your XML presentation with someone they will have to download a Compatibility Pack. They will see a message similar to the one below when they try to open this file on an older version.
If they click “Yes” – they should be taken to a Microsoft Compatibility Page site for this download. The current site is: http://www.microsoft.com/office/preview/beta/converter.mspx.

“The presentation they see may not look exactly like the one you created if it contains features from PowerPoint 2007 that they don’t have. But they can open, edit, and save it in the format for PowerPoint 2007.” (2007 Microsoft Office Preview webpage)

**PowerPoint 97-2003 Presentation** — as indicated, this choice is totally compatible with older versions of PowerPoint.

**PDF or XPS** — You can now save your presentations as PDF Files! Wow!

For this tutorial we are going to save our file as a PowerPoint Presentation.

In the **upper left corner**, of the Menu Screen that appears, you will see: **Save in:** (see **top arrow**). **Click** on the small “V” to the **right of the area next to Save in:** (see **arrows**) and it will show you the various **disk drives available** on which you can save (**image below**). Point to the **drive you desire**, and **click-on it**. If you choose the **3½ Floppy (A:)** – make sure you have a **formatted diskette in the A drive**. If you choose the **C:** drive, choose the folder in which you want to save, by double clicking quickly on the folder.

Now click in the box to the right of **File name:** and you will see that How to Make a Great PBJ has already been entered. PowerPoint assumes you desire to name your presentation with the
name of your first text entry in your first slide. If you do not want this name, delete How to Make a Great PBJ and type in the file name you desire. Then click Save (see arrows above).

One of the really nice things about Office 2007 and PowerPoint 2007 is an auto-save feature that will save your file if you forget to – if something causes your computer to “crash.” However, we still think it’s a good idea to save your PowerPoint presentation after each slide. So we’ll remind you to do this.

Other Slide Views

The area running down the left side of the screen, which contained “little” views of your slides, is called Normal View. This is the “default” view for PowerPoint.

In the lower right corner of the screen you will see some “buttons” that look like the image on the right:

This is the PowerPoint View Toolbar.

Slowly point (move) your cursor arrow over each button and pause a moment (don’t click-on any of them yet). Note what the Text Help boxes indicate. The first box (which looks “depressed”) indicates: Normal View. The next: Slide Sorter View. Then, Slide Show.

To the right of the buttons, you will see a Zoom area that will allow you to Zoom in or out to enlarge or decrease the size of your slides.

Each button has its own unique use.

The Normal View gives you a view of the entire slide as well as the “mini-previews” of each slide in the area on the left. This is the one we have been using so far.

You’ll also notice a Click to add notes section at the bottom of the Normal View screen. In this area you can type “speaker notes” for each slide in the lower portion of the screen. When we cover printing, you will see that there is a print selection to print your speaker notes for each slide. Then, during your presentation, you can refer to your printed notes.

Click-on Slide Sorter View.
In **Slide Sorter** View you can see small images of each slide. **In this view you can left click-on a slide and, while holding down the left mouse button, drag your slide to any position in your show that you desire.** This view assists you in arranging your slides in the order that you desire for your presentation. This view is sort of like the old, round 35mm slide show trays where you pulled-out and stuck-in slides, in the order you desired.

The last button is **Slide Show.** Anytime you want to view your presentation, click-on this button. If you click on it now, you will see how the slide, on which you are working, will look. Give it a try if you desire. When you are finished looking at your slide, tap the **Esc button/key** in the top-left part of your **Keyboard.** This will take you back to the View in which you were working.

Click **Normal View** to return to your slide creation area. We’ll work with Slide Sorter View a bit later.

**The Undo Button**

One of the really handy “things” about most Microsoft programs is the **Undo Button** (it looks like the image on the right). If you **make a mistake** – no need to panic – click the **Undo button** and this will remove your mistake. Then you can try again. The Undo Button is found in the **Quick Access Toolbar** on the top left of the screen. Each time you click the Undo button, PowerPoint will “go back” one change. If you “click too far, there is a “Redo button” that will “undo the undo.” They are both very handy when you need them.

**Slide 3**

Click the **down arrow** in the **lower right corner** of the **New Slide button** once again.

When the New Slide choices menu screen appears, click the **Two Content Slide.**

Your **screen** should **look like** the **image below.**
You may use the two lower boxes for either Text or Content.

Click in the top text box - Click to add title - and type: **Tools Needed**

Click in the left Text or Content Box - • Click to add text and type:

**Knife** (tap Enter)
**Spoon** (tap Enter)
**Plate** (tap Enter)
**Glass**

**Right Text or Content Box**

Notice the small images in the right Text or Content Box of the new slide. There are six “tiny” icons in this area that will allow you insert a Table, Chart, SmartArt, Picture, Clip Art or Media Clip. For this slide we want to insert a Clip Art image in this area. So, carefully, move your cursor over the tiny image in the center of the bottom row (see arrow above). When you do, the box will be highlighted and you’ll see a small text help box appear which indicates – Clip Art.

Click-on the Clip Art image (arrow above). An image similar to the one on the left will appear.

Since our presentation tells how to make a peanut butter and jelly sandwich, we typed sandwich in the Search for: box. Then we clicked the Go button (see left arrows above). A Microsoft Clip Art Task Pane then appeared as you see on the left.
Notice that there are a lot of sandwich clip art images available. You can “run down” the choices by using the “elevator bar” on the right side of the Clip Art Task Pane.

Move up and down the selections until you find one you like. Don’t worry that there aren’t many selections that look just like what you want. We’ll show you how to find a lot more clip art as we go through this tutorial.

We moved down the selections until our Clip Art menu screen looked like the one on the right. We chose the “sandwich” on the right. You find an image you like. We then moved our cursor over the RIGHT EDGE of the image we chose and a blue selection bar with a “V” appeared. We clicked the blue bar and the image and drop down menu you see on the right appeared. We moved our cursor over Insert and clicked.

The menu will disappear and you will see the image you selected on the right side of your slide.

Note: if your clip art selection does not appear, and you receive an error message, please read on below (where an explanation is given).

Slide 3 should look similar to the image on the right.

Don’t forget to save your work!
Closing the Clip Art Task Pane

Before we go to Slide 4, we’ll close the Clip Art Task Pane on the right side of the screen. This will give us more room in the center to work on the next slides.

To close the Clip Art Task Pane, click the small “X” in the upper right corner of the Task Pane (image above on right). You will see the Task Pane disappear.

Slide 4

Click the down arrow in the lower right corner of the New Slide button once again.

Slide 4 will be another Title and Content slide. Click the Title and Content image in the New Slide menu screen.

Click on the top Click to add title box and type: Directions

Click on the bottom • Click to add text box and type:

Open jars of peanut butter and jam (tap Enter)
Spread peanut butter on one slice of bread with a knife (tap Enter)
Use a spoon to get jam and spread it on the other slice of bread (tap Enter)
Put two slices together and cut the sandwich in half (tap Enter)
Put the sandwich on a plate (tap Enter)
Pour a glass of milk (tap Enter)
Enjoy

If your text won’t fit in the box completely, click the box and a border will appear around the box. You will notice “little circles” at the four corners and in the middle of the top and bottom, and on each side of you text box. Point to either the center top or center bottom circle. Your cursor will change to a two headed small arrow like the one on the right. Click-on either circle and hold down the left mouse button and drag the top circle up, or the bottom...
circle **down** to **enlarge** the text area so that text fits on the screen. If your “Directions” are now “mixed-in” with the **bulleted text below**, click-on **Directions**. Then click-on the “**edge**” of the “**box**” (a small up-down-left-right arrow will appear – like the one on the right), **hold down the left mouse button**, and **drag the box up a bit**.

### Directions

- Open jars of peanut butter and jam
- Spread peanut butter on one slice of bread with a knife
- Use a spoon to get jam and spread it on the other slice of bread
- Put two slices together and cut the sandwich in half
- Put the sandwich on a plate
- Pour a glass of milk
- Enjoy

Slide 4 should look similar to the image on the right.

**Time to save your work!**

**Slide 5**

Click the **down arrow** in the **lower right corner** of the **New Slide button** once again.

We’ll use the **Title and Content** slide again. Click this slide.

Your **Slide 5** screen should **look like the top of Page 5**.

Click the **Click to Add title** Text box at the **top** and type: **Occasions for Eating PBJ’s**

Click the • **Click to add text** Text box at the **bottom** and type:
School lunches (tap Enter)
Birthday parties (tap Enter)
Picnics (tap Enter)
Visits from persnickety grandchildren (tap Enter)
Late night snacks (tap Enter)
At the pool

Occasions for Eating PBJ’s
• School lunches
• Birthday parties
• Picnics
• Visits from persnickety grandchildren
• Late night snacks
• At the pool

Slide 5 should look similar to the image on the right.

Save your work!

Slide 6

Click the down arrow in the lower right corner of the New Slide button once again.

Slide 6 will be a Title Only slide. Click the Title Only image in the New Slide menu screen.

Click on the top Click to add title box and type: Enjoy your sandwich!
Now, let’s make the letters larger. Highlight your title (Enjoy your sandwich!) Place your cursor at the beginning of the first word, click and hold down the left mouse button and drag your cursor across the words, then release the left button. The Title should be highlighted and looks like the image below. Since you are “really” in Microsoft Word when you are working with text in PowerPoint 2007, you can also place your cursor on Enjoy your sandwich! and quickly click the left mouse button three times and you will notice that the phrase is highlighted.

Enjoy your sandwich!

First, we’ll change the font for the text. Click on the down triangle next to Calibri in the button bar at the top of the screen. Use the elevator bar, on the right of the font screen that appears, and move down and select Times New Roman (see image and arrows at right).

Next, place your cursor on the small down triangle next to the number in the ribbon bar (when your cursor is on the number, the Text Help box will indicate Font Size – see the image and arrow on the right). Click on the down triangle and scroll down to 60 and click on 60. You text should now be larger than before.

One of the neat new features of PowerPoint 2007 – that you might have noticed – as you were moving your cursor down the Fonts, and then the Font Sizes – was that the highlighted text “changed” to the Font or Font Size over which your cursor was located.

If you did not see this, repeat the above Font type and size change again. This time, slowly move your cursor over the Fonts and watch the change, and then over the size and watch the change. Awesome!
Viewing your Slide Show

You have just completed the first stage of your presentation. Go back to Slide 1. You can do this by using the “elevator bar” on the left edge of your screen. If you click at the top of the elevator bar you will keep moving up until you come to your first slide. Click-on Slide 1. It will indicate Slide 1 of 7 in the status area in the lower left corner of your screen. You should recognize this slide as your first slide on How to make a Great PBJ.

To view how your slide show will look when you project it onto a screen or monitor, click the View Tab then click the Slide Show button (like the image on the right).

There are several ways to advance through your slide show. You can tap the space bar, tap the Enter key, tap the right arrow key, or click the left mouse button to move forward from one slide to the next (during the show). When you get to the end of the “show” the presentation will return to your slides. Anytime you want to end the show, simply tap the Esc key in the upper left corner of the keyboard or click the right mouse button and click on End Show in the pop up menu that appears. If you end your show “early” you will be on the slide you were viewing when you tapped Esc or clicked-on End Show.

To “go backward,” to a previous slide in your show, you can tap the Backspace key, or the left arrow key. If you are using the mouse to “click” through your presentation and desire to go back, click the RIGHT mouse button and you will see a menu screen appear that allows you to choose a Previous slide or Go to any slide.
Transitions:

Now we’ll **add some pizzazz** to our presentation. When you viewed your slide show, a few moments ago, it was like “flopping down” plastic transparencies on an overhead projector.” Nothing really fantastic. Now we’ll add some motion, animation, sound, and color and really make our presentation something to view.

Go to the **Slide Sorter** button at the **bottom right** area of your screen. **Click** on the **button** with **four white squares**.

You can **now see all seven slides** (as shown **below**). **Lightly, click once** on the **first slide** to **highlight** the slide (an **orange border** will surround the slide – see **arrow below**). Now point in the **MIDDLE** of Slide 1 and **click** on your **RIGHT** mouse button.

If you accidentally quick twice on Slide 1, this will take you to the Slide View, again. If this happens, simply click on the Slide Sorter View button at the bottom of the screen, just like you did on the last page.

With Slide 1 “marked,” **click** the Animations Tab. The Animations Ribbon will again open.

**For previous PowerPoint users, this is another “totally new” method.**
Notice in the Animations Ribbon a Group – **Transition to This Slide**.

Transitions are neat, visual actions, as we move from slide to slide in our show. To get a “feel” for what Transitions do, **click the More Arrow in the lower right corner** of the Transition to This Slide Group.

A Transition selection screen similar to the image on the right will appear.

So, let’s get started in creating some **movement (transitions)** as we enhance our PowerPoint slide show. Remember that we clicked-on Slide 1 to begin this process. We have enlarged the Fades and Dissolves and Wipes sections of the Transitions image on the last page. We moved our cursor over Wipe Up and clicked on it. Immediately our Slide 1 Transitioned with a Wipe Up.
At the **bottom** of the **Transition to This Slide** Group there is a **Random** area. One of the choices has a **Question Mark ( ? )**. We **chose this selection** and then **chose Apply to All Slides**. So, when we show our slides, each slide will **transition** with a different effect.

Go ahead and try as many Slide Transitions as you desire. When you have one you like, **look** at the **lower left corner** of **Slide 1**. You will **see a small “shooting” star**. This means that a transition has been applied to this slide. If you **click** the **star**, you will see the transition you selected will **Play** again.

You can **repeat** the above process by **clicking** on **each slide** and selecting a different transition for each slide. Or – **Notice** - on the **right side** of the **Transition to This Slide Group** – you can select Apply to All. And the transition you choose will be applied to all of your slides. It’s up to you on how you want each slide to transition – or not transition.

Also **notice** that there is a **Transition Speed** selection in this same area. You may change your transition from **Fast** to **Medium** or **Slow**.

You may also add a **Sound** to your transition. Click the small down arrow to the right of Transition Sound. A drop down list of sounds will appear. We chose Chime for our Slide 1 Transition.

**Note:** many audiences do not like a lot of “sound” when watching a PowerPoint presentation. So, you may desire to use sound “sparingly” in your presentation.
Go ahead and run/play your slide show again.

**Don’t forget to save your work!**

**Themes**

Finally, we’ll apply **Themes** to our slides.

For those who are familiar with previous versions of PowerPoint, Themes are similar to the Design Templates. For those using PowerPoint for the first time we’ll show you how to use Design Templates on individual slides, or on all of the slides in your presentation. If you are not on the Design Tab/Ribbon, click the Design Tab. You will see the **Themes Group**.

We “cleared” our Slide 2 (using the **Undo Arrow**) so that the Slide 2, on the left of our screen, looks like the image on the right.

Once again, as we move our cursor over a Theme, we see that Slide 2 reflects our choice.
To view additional Themes, click the More arrow in the lower right corner of the Themes Group.

As you move your cursor over these additional Themes, you will see the Theme appear in Slide 2.

If you click a Theme, PowerPoint will assume you desire to select this Theme for ALL the slides in your presentation. We clicked on the Verve Theme you see on the left.

As you can see (in the image on the right) all of the slides were changed to the Verve theme – except Slide 1. Since we indicated that Slide 1 should use a Color Scheme, it remained unchanged.

If this is not what you desire, click the Undo Arrow and begin again.
If you want a different Theme for different slides, **click** on a slide, then **move your cursor** over the theme you desire and click the **RIGHT** mouse button. The **pop-up menu** on the **left** will appear. **Choose Apply to Selected Slides.**

We clicked Slide 2 and followed the instructions above. Our Slide 2 now looks like the image on the right. Notice that Slide 3 remains the same.

Many PowerPoint users desire to have a single theme or color scheme for their presentations.

It might be wise to check with folks who know your audience before you create a lot of different slides with animations and sounds to make sure you know what they desire.

You can choose the view you like best when you are applying Color Schemes and Themes. We used the Normal View above. Many users like to use the Slide Sorter View as they select their choices – so they can see all of their slides.

To **change your view to Slide Sorter View** (like we did on Page 8), look at the **lower right corner of your screen** and click on the Slide Sorter button.
When we clicked the Slide Sorter View button, our screen looked like the image below.

We decided to have the same Theme for all of our slides, so we chose one we liked. Our Slide Sorter View now looks like the image below.

You choose a Color Scheme, Theme or combination that you like for your slides. Notice that when the Theme was applied that, in addition to the background changing, the text, formatting, and colors of some of your objects also changed. In a minute we’ll view our entire slide show again. As you go through your show, you might want to make a note of color changes that do not enhance your presentation. Most notably, when you choose Dimming for text, the Dimming often is more noticeable than the text. So, you might want to change your dimming color to work with your slide show.
Run the show:

Now you have a real presentation! Make sure you are on Slide # 1. Go to Slide # 1 either in Slide Sorter View or Normal View.

To view your show, you can click the View Tab and then click the Slide Show button.

Or, you can just click on the Slide Show button at the bottom of the screen (on the lower right).

To advance (go forward to the next slide or have text or graphics enter), you can tap the left mouse button, Space Bar, Right Arrow key or Enter key. If you want to “go back” to a previous slide (or effect), tap either the back arrow key or the Backspace key on the keyboard. You can also click the RIGHT mouse button at any time and a menu will appear that will assist you to move between the slides.

If you desire to end the show, either tap the Esc key, in the upper left portion of the keyboard, or click the right mouse button and then click End Show.

Practice moving through your slide show a number of times to get the “feel” of how PowerPoint 2007 works.
If you created set times on the Animations Tab for your slides (Pages 55-58), and desire to have the show run in “automatic,” click the Slide Show Tab and then click the Set Up Slide Show button.

The following Set Up Show menu screen will appear.

In the Advance slides box (image above), click the circular area to the left of Using timings, if present. Look over the other choices in this menu screen. Notice that there are a lot of enhancements in this Set Up Show menu screen. Experiment, as you desire. You can always come back and change them. Click the OK button when you have made your changes. One thing people find most helpful, if they desire to have the show repeat continuously, is the Loop continuously until ‘Esc’ selection. This is indicated by an arrow to the Show options area.
Microsoft Office Tutorials

In addition to this tutorial, other Office tutorials are available at:

http://www.officetutorials.com

This site is updated frequently with tutorial revisions as well as tutorials from a number of collegiate institutions. Please feel free to visit and download as you desire.

This has been an introduction into the basics of PowerPoint 2007. If you have any questions about PowerPoint 2007, or comments on this tutorial, please contact:

murray.t@lynchburg.edu

Thank you for your patience and good luck.